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C H A P T E R 14

Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15600 SDH.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15600 SDH Troubleshooting Guide as necessary. This section lists 
the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-F220 Inspect and Maintain the Air Filter, page 14-2—Complete as needed.

2. NTP-F221 Back Up the Database, page 14-4—Complete as needed.

3. NTP-F222 Restore the Database, page 14-6—Complete as needed.

4. NTP-F223 View and Manage OSI Information, page 14-7—Complete as needed.

5. NTP-F224 Restore the Node to Factory Configuration, page 14-8—Complete as needed.

6. NTP-F225 Initiate an External Switching Command on an Optical Protection Group, 
page 14-9—Complete as needed.

7. NTP-F226 Initiate an External Switching Command on an SNCP Circuit, page 14-10—Complete as 
needed.

8. NTP-F227 Initiate an External Switching Command on an MS-SPRing, page 14-11—Complete as 
needed.

9. NTP-F228 View Audit Trail Records, page 14-12—Complete as needed.

10. NTP-F229 Off-Load the Audit Trail Record, page 14-14—Complete as needed.

11. NTP-F230 Off-Load the Diagnostics File, page 14-15—Complete as needed.

12. NTP-F231 Clean Fiber Connectors and Adapters, page 14-16—Complete as needed.

13. NTP-F232 Perform a Soft-Reset Using CTC, page 14-17—Complete as needed.

14. NTP-F233 Perform a Hard-Reset Using CTC, page 14-17—Complete as needed.

15. NTP-F234 Change the Node Timing Reference, page 14-18—Complete as needed.

16. NTP-F235 View the ONS 15600 SDH Timing Report, page 14-19—Complete as needed.

17. NTP-F236 Replace an SSXC Card, page 14-22—Complete as needed.

18. NTP-F237 Replace an STM-16 or STM-64 Card, page 14-23—Complete as needed.

19. NTP-F238 Replace a 4PIO or 1PIO in the ASAP Card, page 14-25—Complete as needed.
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20. NTP-F239 Replace a TSC Card, page 14-27—Complete as needed.

21. NTP-F240 Replace a Fan Tray, page 14-28—Complete as needed.

22. NTP-F241 Replace the Customer Access Panel, page 14-29—Complete as needed.

23. NTP-F242 Remove a Power Distribution Unit, page 14-31—Complete as needed.

24. NTP-F243 Replace the Power Distribution Unit, page 14-33—Complete as needed.

25. NTP-F244 Edit Network Element Defaults, page 14-34—Complete as needed to edit the 
factory-configured (default) network element settings for the Cisco ONS 15600 SDH.

26. NTP-F245 Import Network Element Defaults, page 14-35—Complete as needed to import the 
factory-configured (default) network element settings for the Cisco ONS 15600 SDH.

27. NTP-F246 Export Network Element Defaults, page 14-36—Complete as needed to export the 
factory-configured (default) network element settings for the Cisco ONS 15600 SDH.

Note The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE issue 4.

NTP-F220 Inspect and Maintain the Air Filter

Note The fan filters are single-use only. They must not be cleaned and reused. This is a Telcordia NEBS 
requirement, GR-63-CORE Issue 4.

Note Air filters must be inspected every month. If they are dirty or clogged with dust, they must be replaced 
with a new air filter.

Step 1 Remove the front door of the shelf assembly by completing the following substeps. If the front door is 
already removed, continue with Step 2.

a. Locate the latches on the bottom left and right sides of the door.

b. Pull each latch outward to release the latch.

c. Swing the door up to open it.

d. Lift the door off its hinge pins and remove it. Set the door aside so you can reinstall it after you 
complete this procedure.

Step 2 Gently remove the air filter from the shelf assembly (Figure 14-1). Be careful not to dislodge any dust 
that may have collected on the filter.

Purpose This procedure explains how to inspect and maintain reusable fan tray 
air filters.

Tools/Equipment New air filter and pinned hex key

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 14-1 Removing a Reusable Air Filter (Front Door Removed)

Step 3 Visually inspect the white filter material for dirt and dust. 

Step 4 Replace the air filter with a new one if the air filter is dirty or clogged with dust.

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can 
damage the ONS 15600 SDH cards.

Step 5 Reinstall the front door of the shelf assembly:

a. Insert the front door (removed in Step 1) into the hinge pins on the shelf assembly.

b. Lower the door onto the face of the shelf assembly.

c. Pull the metal latches on the door outward and gently push the door toward the shelf, making sure 
no optical cables are caught or pinched in the door.

d. Click the latches in place and release.

Stop. You have completed this procedure.
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NTP-F221 Back Up the Database

Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a 
backed up database with a different node name, the circuits map to the new node name. Cisco 
recommends keeping a record of the old and new node names.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node you want to back up. If you are 
already logged in, continue with Step 2.

Step 2 In node view, click the Maintenance > Database tabs. (Figure 14-2).

Purpose This procedure stores a backup version of the CTC software database on 
a workstation running CTC or on a network server. Cisco recommends 
performing a database backup at approximately weekly intervals and 
prior to and after configuration changes.

Tools/Equipment None

Prerequisite Procedures NTP-F118 Install the Common Control Cards, page 2-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Figure 14-2 Backing Up the TSC Database

Step 3 Click Backup.

Step 4 In the Database Backup window, click Browse. Repeat for the next Database Backup window.

Step 5 In the Save window, navigate to a local PC directory or network directory and enter a database name 
(such as database.db) in the File name field. 

Step 6 Click Save.

Step 7 In the Database Backup window, click the Alarms check box and/or Performance check box if you 
want to backup these database items in addition to provisioning information (Figure 14-3). 
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Figure 14-3 Database Filename Entered and Backup Options Checked

Note Provisioning is a default component of the backup file. 

Step 8 Click OK.

Step 9 If you are overwriting an existing file, click OK in the confirmation dialog box. 

Step 10 Click OK in the Database Backup window. 

Stop. You have completed this procedure.

NTP-F222 Restore the Database

Caution Restoring an out-of-date database or a database from a different node might affect the service. Any 
provisioning data that currently exists on the node, but not present in the database file being restored, 
will be deleted.

Note The following parameters are not backed up and restored: Node name, subnet mask and gateway, and 
IIOP port. If you change the node name and then restore a backed up database with a different node 
name, the circuits will map to the new renamed node. Cisco recommends keeping a record of the old and 
new node names.

Purpose This procedure restores the TSC software database.

Tools/Equipment None

Prerequisite Procedures NTP-F221 Back Up the Database, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note You need separate backups for each node in a circuit path to be able to restore the entire circuit.

Note If you want to revert to a previously loaded software version, refer to the platform-specific upgrade 
document for instructions.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you are performing the 
database restore. If you are already logged in, continue with Step 2.

Step 2 In node view, click the Maintenance > Database tabs.

Step 3 Click Restore.

Step 4 In the Database Restore window, click the Alarms check box and/or Performance check box to choose 
these database items in addition to provisioning information. 

Note You can back up five databases as part of one back up file package; therefore the 15600 SDH 
allows you to select all of the files or a subset of the files to restore as part of the restore package.

Step 5 In the Database Restore window, click Browse. 

Step 6 Navigate to the backup file stored on the workstation hard drive or on network storage.

Step 7 Click the database file to highlight it.

Step 8 Click Open. The Database Restore dialog box appears. 

Step 9 Click Restore. 

The Database Restore window monitors the file transfer. Wait for the file to complete the transfer to the 
TSC.

Step 10 Click OK in the Lost connection to node, changing to Network View dialog box. Wait for the node to 
reconnect.

Stop. You have completed this procedure.

NTP-F223 View and Manage OSI Information

Purpose This procedure allows you to view and manage OSI including the ES-IS 
and IS-IS routing information bases, TARP data cache, and manual area 
table.

Tools/Equipment None

Prerequisite Procedures NTP-F221 Back Up the Database, page 14-4

NTP-F143 Provision OSI, page 4-14

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Refer to the “Management Network Connectivity” chapter of the Cisco ONS 15600 SDH Reference 
Manual for additional information about OSI.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32. If you are already logged in, continue with 
Step 2.

Step 2 Perform any of the following tasks as needed:

• DLP-F376 View IS-IS Routing Information Base, page 18-86

• DLP-F377 View ES-IS Routing Information Base, page 18-87

• DLP-F378 Manage the TARP Data Cache, page 18-87

Stop. You have completed this procedure.

NTP-F224 Restore the Node to Factory Configuration

Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinit tool chooses the first product-specific database in the specified directory if you use the Search 
Path field instead of the Package and Database fields. You may accidentally copy an incorrect database 
if multiple databases are kept in the specified directory.

Purpose This procedure reinitializes the ONS 15600 SDH using the CTC 
reinitialization tool. Reinitialization uploads a new software package to 
the control card, clears the node database, and restores the factory 
default parameters.

Tools/Equipment Cisco ONS 15600 SDH System Software CD, Version 9.1 or 9.2.1

JRE 5.0 (JRE 1.6 for Release 9.2.1 and later) must be installed on the 
computer to log into a Software R8.0node when reinitialization is 
complete. The reinitialization tool can run on JRE 1.3.1_02, JRE 1.4.2, 
or JRE 5.0.

Prerequisite Procedures NTP-F221 Back Up the Database, page 14-4

NTP-F126 Set Up Computer for CTC, page 3-1

One of the following:

• NTP-F127 Set Up CTC Computer for Local Craft Connection to the 
ONS 15600 SDH, page 3-3 or

• NTP-F128 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15600 SDH, page 3-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Cisco recommends that you take care to save the node database to safe location if you are not restoring 
the node using the database provided on the software CD.

Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1 If you are using Microsoft Windows, complete the “DLP-F278 Use the Reinitialization Tool to Clear the 
Database and Upload Software (Windows)” task on page 17-69.

Step 2 If you are using UNIX, complete the “DLP-F323 Use the Reinitialization Tool to Clear the Database and 
Upload Software (UNIX)” task on page 18-21.

Stop. You have completed this procedure.

NTP-F225 Initiate an External Switching Command on an Optical 
Protection Group

Note If you choose a Manual switch, the command will switch traffic only if the path has an error rate less 
than the signal degrade bit error rate threshold. A Force switch will switch traffic even if the path has 
SD or SF conditions. A Force switch has a higher priority than a Manual switch. Lockouts can only be 
applied to protect cards; they prevent traffic from switching to the protect port under any circumstance. 
Lock outs have the highest priority. A lock on can be applied to the working port; it prevents traffic from 
switching to the protect port in the protection group. 

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to inhibit 1+1 
group protection switching. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-F238 Initiate a Manual Switch on a Port in a 1+1 Protection Group” task on 
page 17-31 as needed.

Purpose This procedure describes how apply an external switching command 
(Force, Manual, lock on or lockout) to an optical protection group.

Tools/Equipment None

Prerequisite Procedures NTP-F138 Create a 1+1 Protection Group, page 4-10

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Complete the “DLP-F239 Initiate a Force Switch on a Port in a 1+1 Protection Group” task on 
page 17-32 as needed.

Step 4 Complete the “DLP-F295 Clear a Manual or Force Switch in a 1+1 Protection Group” task on 
page 17-86 as needed.

Step 5 To prevent traffic on a working port from switching to the protect port, complete the “DLP-F240 Apply 
a Lock On in a 1+1 Group” task on page 17-33.

Step 6 To prevent working traffic from switching to the protect port, complete the “DLP-F241 Apply a Lockout 
in a 1+1 Group” task on page 17-34 to lockout the protect port. 

Step 7 Complete the “DLP-F296 Clear a Lock On or Lockout in a 1+1 Protection Group” task on page 17-86 
as needed.

Note Refer to the “Card Protection” chapter in the Cisco ONS 15600 SDH Reference Manual for a 
description of protection switching and switch state priorities.

Stop. You have completed this procedure.

NTP-F226 Initiate an External Switching Command on an SNCP 
Circuit

Note A Manual switch will switch traffic if the path has an error rate less than the signal degrade. A Force 
switch will switch traffic even if the path has signal degrade (SD) or signal fail (SF) conditions. A Force 
switch has a higher priority than a Manual switch. Lockouts prevent traffic from switching under any 
circumstance and have the highest priority. 

Note This procedure switches traffic on a single SNCP circuit; to switch all circuits on a span, see the 
“DLP-F235 Switch All SNCP Circuits on a Span” task on page 17-29.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to switch traffic 
on a SNCP circuit. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-F242 Initiate a Manual Switch on an SNCP Circuit” task on page 17-35 as needed.

Step 3 Complete the “DLP-F243 Initiate a Force Switch to an SNCP Circuit” task on page 17-35 as needed.

Purpose This procedure initiates a Manual, Force, or lockout switch on a 
subnetwork connection protection ring (SNCP) circuit. 

Tools/Equipment None

Prerequisite Procedures NTP-F152 Provision SNCP Nodes, page 5-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Complete the “DLP-F297 Initiate a Lockout on an SNCP Path” task on page 17-87 to prevent traffic 
from switching to the protect path.

Step 5 Complete the “DLP-F298 Clear a Switch or Lockout on an SNCP Circuit” task on page 17-88 as needed.

Note Refer to the Cisco ONS 15600 SDH Reference Manual for a description of protection switching 
and switch state priorities.

Stop. You have completed this procedure.

NTP-F227 Initiate an External Switching Command on an 
MS-SPRing

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to switch traffic 
on a SNCP circuit. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-F344 Initiate an MS-SPRing Manual Ring Switch” task on page 18-47 as needed.

Step 3 Complete the “DLP-F345 Clear an MS-SPRing Manual Ring Switch” task on page 18-48 as needed.

Step 4 Complete the “DLP-F347 Initiate an MS-SPRing Force Ring Switch” task on page 18-50 as needed.

Step 5 Complete the “DLP-F282 Clear an MS-SPRing Force Ring Switch” task on page 17-74 as needed.

Stop. You have completed this procedure.

Purpose This procedure initiates and clears multiplex section-shared protection 
ring (MS-SPRing) manual ring switches and MS-SPRing force ring 
switches. A Manual switch will switch traffic if the path has an error rate 
less than the signal degrade. A Force switch will switch traffic even if 
the path has SD or SF conditions. A Force switch has a higher priority 
than a Manual switch. 

Tools/Equipment None

Prerequisite Procedures NTP-F147 Provision MS-SPRing Nodes, page 5-6

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-F228 View Audit Trail Records

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to view the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

A window containing the most recent Audit Trail records appears as shown in Figure 14-4.

Purpose This procedure explains how to view audit trail records. Audit trail 
records are useful for maintaining security, recovering lost transactions, 
and enforcing accountability. Accountability refers to tracing user 
activities; that is, associating a process or action with a specific user.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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Figure 14-4 Viewing the Audit Trail Records

A definition of each column in the Audit Trail log is listed in Table 14-1.

Right-click on the column headings to display the list in ascending-to-descending or 
descending-to-ascending order. 

Left-click on the column heading to display the following options:

• Reset Sorting—Resets the column to the default setting

• Hide Column—Hides the column from view

• Reset Columns Order/Visibility—Displays all hidden columns

Table 14-1 Audit Trail Column Definitions

Column Definition

Date Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (that is, whether or not the action was executed)

Operation Action that was taken
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• Row Count—Provides a numerical count of log entries

Shift-click on the column heading for an incremental sort of the list.

Stop. You have completed this procedure.

NTP-F229 Off-Load the Audit Trail Record

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to off-load the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save.

640 entries are saved in this file. The next entries continue with the next number in the sequence, rather 
than starting over.

Note Archiving does not delete entries from the CTC audit trail log. However, entries can be 
self-deleted by the system after the log maximum is reached. If you archived the entries, you 
cannot reimport the log file back into CTC and will have to view the log in a different 
application.

Stop. You have completed this procedure.

Purpose This procedure describes how to off-load up to 640 audit trail log entries 
to a local or network drive file to maintain a record of actions performed 
for the node. If the audit trail log is not off-loaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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NTP-F230 Off-Load the Diagnostics File

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to off-load the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Diagnostic tabs.

Step 3 Click Retrieve Tech Support Log.

Step 4 In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be 
unzipped and read by Cisco Technical Support.

Step 6 Click Save.

The Get Diagnostics status window shows a progress bar indicating the percentage of the file being 
saved, then shows “Get Diagnostics Complete.”

Step 7 Click OK.

Stop. You have completed this procedure.

Purpose This procedure describe how to off-load a diagnostic file. The diagnostic 
file contains a set of debug commands run on a node and its results. This 
file is useful to TAC when troubleshooting problems with the node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance
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NTP-F231 Clean Fiber Connectors and Adapters

Warning Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into 
beams or view directly with optical instruments. Statement 1051

Caution Follow established site safety practices when working with any laser equipment.

Step 1 Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2 Replace any damaged fiber connectors.

Note Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3 Complete the “DLP-F245 Clean Fiber Connectors” task on page 17-37 as necessary.

Step 4 Complete the “DLP-F246 Clean the Fiber Adapters” task on page 17-39 as necessary.

Caution Do not reuse the optical swabs. Keep unused swabs off of work surfaces.

Stop. You have completed this procedure.

Purpose This procedure cleans the fiber connectors and adapters.

Tools/Equipment Inspection microscope (suggested: Westover FBP-CIS-1)

Scrub tool

Grounding strap

Wipes

Rinse tool

HFE-based cleaning fluid and pump head assembly

Replacement scrub tool wipes

Replacement rinse tool absorbent pads

Desktop hand tool 

Pen-type hand tool 

3M high-performance fiber-optic wipes

Empty disposable container

Canned air

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-F232 Perform a Soft-Reset Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Before you reset the card, you should wait at least 60 seconds after the last provisioning change you 
made to avoid losing any changes to the database.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to perform the 
card reset. If you are already logged in, continue with Step 2.

Step 2 In node view, right-click the appropriate card to reveal a drop-down list.

Step 3 Click Soft-Reset Card.

Step 4 Click Yes in the “Are you sure you want to soft-rest this card?” dialog box.

Step 5 Click OK in the “Lost connection to node, changing to Network View” dialog box.

Note For LED behavior during a TSC/SSXC reboot, see Table 2-1 on page 2-3.

Stop. You have completed this procedure.

NTP-F233 Perform a Hard-Reset Using CTC

Purpose This procedure resets an active card and switches the node to the 
redundant card using a soft reset.

Tools/Equipment None

Prerequisite Procedures NTP-F118 Install the Common Control Cards, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This procedure resets the active card (TSC, SSXC, optical, ASAP) and 
switches the node to the redundant card using a hard reset.

Tools/Equipment None

Prerequisite Procedures NTP-F118 Install the Common Control Cards, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note The hard-reset option is enabled only when the card is placed in the locked-enabled, maintenance service 
state.

Note Before you reset the TSC, you should wait at least 60 seconds after the last provisioning change you 
made to avoid losing any changes to the database.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to perform the 
TSC card reset. If you are already logged in, continue with Step 2.

Step 2 In node view click the Inventory tab. Locate the appropriate card in the inventory list.

Step 3 Click the Admin State drop-down list and select locked, maintenance. Click Apply.

Step 4 Click Yes in the “Action may be service affecting. Is it OK to apply the changes?” dialog box.

Step 5 The service state of the card becomes locked-enabled, maintenance. The card’s faceplate appears blue 
in CTC and the SRV LED turns amber.

Step 6 Right-click the card to reveal a pop-up menu.

Step 7 Click Hard-reset Card.

Step 8 Click Yes in the “Are you sure you want to hard-reset this card?” dialog box. 

Step 9 If you hard-reset the active TSC, click OK in the “Lost connection to node, changing to Network View” 
dialog box.

Note For LED behavior during a TSC reboot, see Table 2-1 on page 2-3.

Stop. You have completed this procedure.

NTP-F234 Change the Node Timing Reference

Purpose This procedure switches the node timing reference to enable 
maintenance on a timing reference or returning the node timing to 
normal operation.

Tools/Equipment None

Prerequisite Procedures NTP-F137 Set Up Timing, page 4-9

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Maintenance or higher
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Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to change the 
node timing reference. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-F259 Manual Switch the Node Timing Reference” task on page 17-52 as needed.

Step 3 Complete the “DLP-F260 Clear a Manual Switch on a Node Timing Reference” task on page 17-53 as 
needed.

Stop. You have completed this procedure.

NTP-F235 View the ONS 15600 SDH Timing Report

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to view the 
node timing status. If you are already logged in, continue with Step 2.

Step 2 Click the Maintenance > Timing > Report tabs.

Step 3 In the Timing Report area, you can view node timing information. The date and time of the report appear 
at the top of the report. Table 14-2 describes the report fields and entries. 

Step 4 To update the report, click Refresh.

Purpose This procedure displays the current status of the ONS 15600 SDH 
timing references.

Tools/Equipment None

Prerequisite Procedures NTP-F137 Set Up Timing, page 4-9

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 14-2 ONS 15600 SDH Timing Report

Item Description Option Option Description

Clock Indicates the 
timing clock. 
The report 
section that 
follows applies 
to the timing 
clock indicated.

NE The node timing clock.

BITS-1 Out The BITS-1 Out timing clock.

BITS-2 Out The BITS-2 Out timing clock.
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Status

Status 
(cont.)

Indicates the 
status of the 
timing clock.

INIT_STATE The timing reference has not been provisioned. For an 
NE reference, this status appears just before the first 
provisioning messages when the TSC is booting. Timing 
is provisioned to the internal clock of the node.

HOLDOVER_STATE The clock was locked onto a valid timing reference for 
more than 140 seconds when a failure occurred. 
Holdover state timing is a computation based on timing 
during normal state combined with the node’s internal 
clock. The node holds onto this frequency until the valid 
reference is restored. This status appears for NE 
references only.

FREERUN_STATE The node is running off its internal clock without any 
modification except the calibrated value to bring timing 
to 0 PPM. Free-run state can occur when a Force switch 
to the internal clock is initiated, all references fail 
without the 140 seconds of holdover data, or only 
Internal timing references are defined. This status 
appears for NE references only.

NO_SYNC_STATE A synchronization timing reference is not defined. 
BITS-1 Out or BITS-2 Out default to this status until an 
STM-N card is defined as its reference on the 
Provisioning > Timing tab. This status appears for 
external references only.

NE_SYNCH_STATE BITS-1 Out and BITS-2 Out use the same timing source 
as the NE. This is displayed when NE Reference is 
selected for BITS-1 Out and BITS-2 Out Reference List 
on the Provisioning > Timing tab.

NORMAL_STATE The timing reference is locked onto one of its 
provisioned references. The reference cannot be Internal 
or no sync state.

FAST_START_STATE The node has switched references, but the reference is 
too far away to reach normal state within an acceptable 
amount of time. Fast Start is a fast acquisition mode to 
allow the node to quickly acquire the reference. After it 
achieves this goal, the node progresses to the normal 
state.

FAST_START_FAILED_STATE A timing reference is too far away to reach in normal 
state. The fast start state could not acquire sufficient 
timing information within the allowable amount of time.

Status 
Changed 
At

Date and time of 
the last status 
change.

— —

Switch 
Type

Type of switch. AUTOMATIC The timing switch was system-generated.

Manual The timing switch was a user-initiated Manual switch.

Force The timing switch was user-initiated Force switch.

Table 14-2 ONS 15600 SDH Timing Report (continued)

Item Description Option Option Description
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Reference Indicates the 
timing 
reference.

Three timing references (Ref-1, 
Ref-2, and Ref-3) are available on 
the Provisioning > Timing tab. 

These options indicate the timing references that the 
system uses, and the order in which they are called. (For 
example, if Ref-1 becomes available, Ref-2 is called.)

Selected Indicates 
whether the 
reference is 
selected.

Selected references are indicated 
with an X.

—

Facility Indicates the 
timing facility 
provisioned for 
the reference on 
the 
Provisioning > 
Timing tab.

BITS-1 The timing facility is a building integrated timing supply 
(BITS) clock attached to the node’s BITS-1 pins.

BITS-2 The timing facility is a BITS clock attached to the node’s 
BITS-2 pins.

STM-N card with port # If the node is set to line timing, this is the STM-N card 
and port provisioned as the timing reference.

Internal clock The node is using its internal clock.

State Indicates the 
timing reference 
state.

unlocked The timing reference is operational.

locked The timing reference is not operational.

Condition Indicates the 
timing reference 
state.

OKAY The reference is valid to use as a timing reference.

OOB Out of bounds; the reference is not valid and cannot be 
used as a timing reference, for example, a BITS clock is 
disconnected.

Condition 
Changed

Indicates the 
date and time of 
the last status 
change in 
MM/DD/YY 
HH:MM:SS 
format.

— —

SSM Indicates 
whether SSM is 
enabled for the 
timing 
reference.

Enabled SSM is enabled.

Disabled SSM is not enabled.

SSM 
Quality

Indicates the 
SSM timing 
quality.

8 to 10 SSM quality messages 
might be displayed.

For a list of SSM message sets, refer to the 
Cisco ONS 15600 SDH Reference Manual.

SSM 
Changed

Indicates the 
date and time of 
the last SSM 
status change in 
MM/DD/YY 
HH:MM:SS 
format.

— —

Table 14-2 ONS 15600 SDH Timing Report (continued)

Item Description Option Option Description
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Stop. You have completed this procedure.

NTP-F236 Replace an SSXC Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note The ONS 15600 SDH system dynamically changes the preferred copy status from one SSXC to the 
redundant copy if an error is detected on a card port. You can see this change in the CTC node view 
Maintenance > Preferred Copy window Currently Used field. If errors are detected on both SSXC 
copies, the Currently Used field says Both.

Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an improper removal (IMPROPRMVL) alarm, but this clears after the card 
replacement is complete.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 for the node where you will replace the 
SSXC card. 

Step 2 In node view click the Inventory tab. Locate the appropriate SSXC card in the inventory list.

Step 3 Click the Admin State drop-down list and select locked, maintenance. Click Apply.

Step 4 Click the Maintenance > Preferred Copy tabs. Verify that the SSXC selected as the preferred data copy 
is not the SSXC you want to remove.

Step 5 Physically remove the SSXC card to be replaced from the ONS 15600 SDH shelf:

a. Open the card ejectors.

b. Slide the card out of the slot.

Note An UNPROT-XCMTX alarm will be reported when you remove the SSXC card.

Purpose This procedure replaces a faulty SSXC card with a new SSXC card. 

Tools/Equipment Replacement SSXC card

Prerequisite Procedures NTP-F221 Back Up the Database, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Install the replacement SSXC card in the shelf:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Step 7 Wait for the new card to boot. (This will take approximately one minute.) Ensure that the 
UNPROT-XCMTX alarm clears.

Step 8 In node view click the Inventory tab. Locate the newly installed SSXC card in the inventory list.

Step 9 Click the Admin State drop-down list and select unlocked. Click Apply.

Note When you replace a card with an identical type of card, you do not need to make any changes 
to the database.

.

NTP-F237 Replace an STM-16 or STM-64 Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Card removal raises an improper removal (IMPROPRMVL) alarm, but this clears after the card 
replacement is completed.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you will replace the 
STM-16 or STM-64 card.

Step 2 Ensure that the card you are replacing does not carry traffic in a 1+1 protection group:

a. In node view, click the Maintenance > Protection tabs.

b. Choose the first group listed under Protection Groups.

c. Verify that the slot number for the card you are replacing does not appear in the Selected Groups 
list. For example, if you are replacing the STM-16 card in Slot 3, make sure that Selected Groups 
does not contain any entries that start with s3, regardless of the port.

d. Repeat Steps b and c for each protection group.

Purpose This procedure replaces an STM-16 or STM-64 traffic card with a new 
card of the same type. 

Tools/Equipment Replacement STM-16 or STM-64 card

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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e. If any of the groups contain a port on the card you want to replace, complete the “DLP-F239 Initiate 
a Force Switch on a Port in a 1+1 Protection Group” task on page 17-32.

Step 3 Ensure that the card you are replacing does not carry SNCP circuit traffic:

Note A port can be part of a 1+1 protection group or part of a SNCP, but it cannot be configured for 
both. However, different ports on one card can be configured in different ways. If you move all 
of the traffic off some 1+1 ports, you still need to check whether the remaining ports are carrying 
SNCP traffic.

a. From the View menu choose Go to Parent View.

b. Click the Circuits tab.

c. View the circuit source and destination ports and slots. If any circuits originate or terminate in the 
slot containing the card you are replacing, perform the “DLP-F235 Switch All SNCP Circuits on a 
Span” task on page 17-29 or the DLP-F347 Initiate an MS-SPRing Force Ring Switch, page 18-50. 

Note If the card you are replacing is not configured for any port or circuit protection, but does 
carry traffic, bridge and roll this traffic onto another card. See the “NTP-F181 Bridge and 
Roll Traffic” procedure on page 7-5.

Step 4 Remove any fiber optic cables from the ports.

Step 5 Physically remove the card that you want to replace from the ONS 15600 SDH shelf:

a. Open the card ejectors.

b. Slide the card out of the slot. 

Step 6 Physically replace the STM-16 or STM-64 card in the shelf:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Note When you replace a card with an identical type of card, you do not need to make any changes 
to the database.

Step 7 Clear the Force switches:

• To clear 1+1 Force switches, complete the “DLP-F295 Clear a Manual or Force Switch in a 1+1 
Protection Group” task on page 17-86.

• To clear SNCP Force switches, complete the “DLP-F236 Clear a Switch for all SNCP Circuits on a 
Span” task on page 17-30.

• To clear MS-SPRing Force switches, complete the “DLP-F282 Clear an MS-SPRing Force Ring 
Switch” task on page 17-74.

Step 8 When the card is in service and receiving traffic, reset the card’s physical receive power level threshold 
in CTC:

a. Double-click the newly installed card in CTC node view.

b. Click the Provisioning > SDH Thresholds tabs.

c. Click the Physical radio button. 
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d. Click Set OPR for each port on the card. 

Step 9 As necessary, refer to the “NTP-F197 Modify Line and Status Thresholds for Optical Ports” procedure 
on page 10-2 to change the optical card settings.

Stop. You have completed this procedure.

NTP-F238 Replace a 4PIO or 1PIO in the ASAP Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Caution Replacing a provisioned 4PIO with a 1PIO (and vice versa) is not supported. You must replace the PIM 
with the same PIM type, unless you have deleted the previously installed module before you install the 
new module type.

Note Card removal raises an improper removal (IMPROPRMVL) alarm, but this clears after the card 
replacement is completed.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you will replace the 1PIO 
or 4PIO module.

Step 2 Ensure that the module you are replacing does not carry traffic in a 1+1 protection group:

a. In node view, click the Maintenance > Protection tabs.

b. Choose the first group listed under Protection Groups.

c. Verify that none of the port numbers for the 4PIO or 1PIO you are replacing does not appear in the 
Selected Groups list. 

d. Repeat Steps b and c for each protection group.

e. If any of the groups contain a port on the card you want to replace, complete the “DLP-F239 Initiate 
a Force Switch on a Port in a 1+1 Protection Group” task on page 17-32.

Step 3 Ensure that the card you are replacing does not carry SNCP circuit traffic:

Purpose This procedure replaces a 4PIO or 1PIO module (PIM) in the ASAP card 
with another module of the same type.

Tools/Equipment Replacement 4PIO(s) and/or 1PIO(s)

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note A port can be part of a 1+1 protection group or part of a SNCP, but it cannot be configured for 
both. However, different ports on one card can be configured in different ways. If you move all 
of the traffic off some 1+1 ports, you still need to check whether the remaining ports are carrying 
SNCP traffic.

a. From the View menu choose Go to Parent View.

b. Click the Circuits tab.

c. View the circuit source and destination ports and slots. If any circuits originate or terminate in the 
slot containing the card you are replacing, perform the “DLP-F235 Switch All SNCP Circuits on a 
Span” task on page 17-29 or the “DLP-F347 Initiate an MS-SPRing Force Ring Switch” task on 
page 18-50. 

Note If the card you are replacing is not configured for any port or circuit protection, but does 
carry traffic, bridge and roll this traffic onto another card. See the “NTP-F181 Bridge and 
Roll Traffic” procedure on page 7-5.

Step 4 Remove any fiber-optic cables from the ports.

Step 5 Physically remove the 4PIO or 1PIO that you want to replace from the ASAP card:

a. Loosen the screws at the top right and bottom left on the 1PIO or 4PIO module. (You can do this 
using a Phillips screwdriver or by hand.)

b. Slide the module out of the slot on the ASAP card. 

Step 6 Physically replace the 4PIO or 1PIO module in the ASAP card:

a. Carefully slide the module along the top and bottom guide rails into the correct slot. 

b. Use a Phillips screwdriver or your hand to tighten the screws at the top right and bottom left of the 
module. 

Note When you replace a card with an identical type of card, you do not need to make any changes 
to the database.

Step 7 Clear the Force switches:

• To clear 1+1 Force switches, complete the “DLP-F295 Clear a Manual or Force Switch in a 1+1 
Protection Group” task on page 17-86.

• To clear SNCP Force switches, complete the “DLP-F236 Clear a Switch for all SNCP Circuits on a 
Span” task on page 17-30.

• To clear MS-SPRing Force switches, complete the “DLP-F282 Clear an MS-SPRing Force Ring 
Switch” task on page 17-74.

Step 8 When the module is in service and receiving traffic, reset the module’s physical receive power level 
threshold in CTC:

a. Double-click the newly installed module in CTC node view.

b. Click the Provisioning > Optical > Optics Thresholds tabs.

c. Click the Physical radio button. 

d. Click Set OPR for each port on the card. 
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Stop. You have completed this procedure.

NTP-F239 Replace a TSC Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note When an error is detected on a TSC card, the ONS 15600 SDH system switches control to the second 
TSC card; therefore, so it should not be necessary to change control when you replace the card.

Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an improper removal (IMPROPRMVL) alarm, but this clears after the card 
replacement is completed.

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you will replace the TSC 
card. 

Step 2 To ensure that the card you are replacing is not the active TSC card, run the mouse over the card in CTC. 
If the card says Active, switch it to Standby:

a. Right-click the active TSC card to reveal the shortcut menu.

b. Click Soft-reset Card.

c. Click Yes when the confirmation dialog box appears.

d. Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note The TSC card takes several minutes to reboot. See Table 2-1 on page 2-3 for more 
information about LED behavior during TSC card reboots.

Purpose This procedure replaces a TSC card with a new TSC card. 

Tools/Equipment Replacement TSC card

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note Whenever TSC cards are changed from active to standby, it takes approximately 12 minutes 
to completely synchronize to the new system clock source due to the more accurate Stratum 
3E timing module being adopted.

Step 3 Confirm that the TSC card you reset is in standby mode after the reset.

A TSC card that is ready for service has a green SRV LED illuminated. An active TSC card has a green 
ACT STBY LED illuminated, but a standby card does not have this LED illuminated.

Tip If you run the cursor over the TSC card in CTC, a popup displays the card’s status (whether active or 
standby).

Step 4 Physically remove the card you want to replace from the ONS 15600 SDH:

a. Open the card ejectors.

b. Slide the card out of the slot. 

Step 5 Insert the replacement TSC card into the empty slot:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Step 6 If you want to make the replaced TSC card active, complete Steps 2b through 2d again.

Stop. You have completed this procedure.

Note The estimated time that a skilled technician takes to replace a fan tray is 2 minutes.

NTP-F240 Replace a Fan Tray

Caution Do not force a fan tray into place. Forcing a fan tray can damage the connectors on the fan tray or the 
connectors on the back panel of the shelf assembly.

Purpose This procedure replaces a fan tray with a new fan tray. 

Tools/Equipment Replacement fan tray

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
14-28
Cisco ONS 15600 SDH Procedure Guide, R9.1 and R9.2.1

78-19883-01



  

Chapter 14 Maintain the Node
NTP- F241 Replace the Customer Access Panel
Caution The center fan tray (tray 2) in the ONS 15600 SDH shelf is the most critical tray because it cools the 
common control cards. If both fans in this tray are inoperative, CTC initiates a five-minute countdown 
to shut down one of the SSXC cards. You should swap a working fan tray (tray 1 or 3) with tray 2 as 
soon as possible to prevent equipment damage.

Caution When a fan tray is removed from a shelf assembly, it momentarily creates the same situation that occurs 
if two fans in a single tray fail. In this situation (that is, the system is running on two fans), CTC software 
begins a five-minute countdown before shutting down SSXC card operation in order to protect the cards. 
Replace the fan tray in the shelf assembly as quickly as possible to avoid SSXC card shutdown.

Note The ONS 15600 SDH system requires at least one working fan in each of the three fan trays. When a 
single fan in a tray fails, Cisco recommends replacing the tray with a fully working tray as soon as 
practically possible. To replace a fan tray, it is not necessary to move any of the cable management 
facilities.

Note Each fan tray contains two fans. The FAN LED indicates if one or both fans fail in a fan tray.

Step 1 Lift the latch on the fan tray that you want to replace, and pull the fan tray away from the shelf assembly.

Step 2 Insert the new fan tray in the shelf assembly.

Step 3 Press the latch down to secure the fan tray.

Stop. You have completed this procedure.

Note The estimated time that a skilled technician takes to replace a fan tray is 2 minutes.

NTP-F241 Replace the Customer Access Panel

Note The 15600 SDH node is viewable only when CTC is connected to its front panel. You will not be able 
to view any other node that is connected to the ONS 15600 SDH through a DCC.

Purpose This procedure replaces a customer access panel (CAP)/customer access 
panel version 2 (CAP2) with a new CAP/CAP2. 

Tools/Equipment Replacement CAP/CAP2

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 1 Remove any tie wraps and cables attached to the CAP/CAP2 (Figure 14-5).

Figure 14-5 CAP/CAP2 Faceplate and Connections

Step 2 Remove the pin-field card, leaving the wires attached if possible. (If this is not possible, remove and 
label the wires.) 

Step 3 To remove the CAP/CAP2:

a. Remove the 14 screws on the left and right sides of the CAP/CAP2 using a 3/16-inch (4.76-mm) 
socket.

b. Remove the 17 nuts on the top and bottom of the CAP/CAP2 using a 1/4-inch (6.35-mm) socket.

c. Loosen the center bolt using a 7/16-inch (11.113-mm) socket. This creates an extraction force on 
the connectors to successfully unmate them.

d. Pull the CAP/CAP2 off of the alignment pins.

Step 4 Place the replacement CAP/CAP2 over the alignment pins on the backplane and tighten the center bolt 
using a 7/16-inch (11.113-mm) socket. This creates an insertion force that successfully mates the 
connectors.

Step 5 Verify that the CAP/CAP2 cover is contacting the rear cover around the CAP/CAP2 perimeter.
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Step 6 Replace the CAP/CAP2 screws and tighten to the specified torque (6 to 7 foot pounds).

Step 7 If you removed the wire-wrap wires from the pin field card, replace them on the pin field according to 
their labeled positions. If you removed the pin field card with the wires intact, reinstall the pin field card.

Step 8 Replace the tie wraps and cables.

Stop. You have completed this procedure.

NTP-F242 Remove a Power Distribution Unit

Note The PDU can be ordered in entirety (including PDU-A, PDU-B, and alarm panel), or by part.

Step 1 Remove a PDU from a donor unit:

a. Secure an ESD-safe area to place dismounted equipment.

b. Working on the front of the donor unit, remove the donor PDU alarm unit from the center of the 
PDU:

• Use a slot screwdriver to loosen the front two screws on the PDU alarm unit until they click.

• Remove the alarm unit from the cabinet by pulling it straight out. Place it in an ESD-safe area.

c. Remove the donor PDU:

• Remove 1/4-inch (6.35-mm) nut and washer from frame ground lug on back side.

• Use a slot screwdriver to loosen the front two screws on the PDU until they click.

• Remove the PDU from the cabinet by pulling it straight out. Place it in an ESD-safe area.

Step 2 Disconnect the faulty PDU:

Note Wiring positions are mirrored for PDU-A and PDU-B with the exception of the frame ground 
wire and are marked on the top face of the PDU.

a. Disconnect DC power to the PDU to be replaced. For more information about bay power 
connections, see the “DLP-F167 Connect Office Power to the ONS 15600 SDH Bay” task on 
page 16-8.

b. Working on the side of the PDU, use a voltage meter to verify that there is no DC power present at 
the terminals. See the “DLP-F169 Verify Office Power” task on page 16-12.

c. Secure an ESD-safe area to place dismounted equipment.

Purpose This procedure removes the ONS 15600 SDH power distribution unit 
(PDU). 

Tools/Equipment Replacement PDU

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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d. Working on the side of the bay, use the 9/64-in. Allen wrench to loosen the two socket-head screws 
holding the plastic safety cover over the power terminals.

e. Remove the side plastic safety cover and screw down the socket-head screws by hand far enough for 
the PDU to clear the chassis when removed.

Note If socket-head screws are left partially screwed outward, the PDU cannot be removed from 
the chassis.

f. Working on the side of the bay, remove the electrical wiring of the faulty PDU:

Note In this procedure, all wiring screw post positions are referenced from right to left, starting 
with screw post one being rear-most. 

• Use a 3/8-in. socket and wrench or socket driver to remove the green ground wire from the first 
vertical pair of screw posts.

• Remove the jumper cable from the frame to logic ground terminals.

• Remove the red 48-VDC power return wire from the third pair of screw posts.

• Remove the black 48-VDC power supply wire from the fourth pair of screw posts.

Note Looking at the back of the power unit from the rear of the bay, there are three areas of 
screw posts on the rear of the unit: (1) The top 12 screw posts hold the busbars; (2) the 
right-bottom (PDU-A) or left-bottom (PDU-B) three screw posts hold the black frame 
ground, and (3) the bottom-left (PDU-A) or bottom-right (PDU-B) six screw posts hold 
the green frame and logic grounds.

g. Working on the rear of the bay, remove the two thumbnuts holding the plastic safety cover. Remove 
the plastic safety cover.

h. Working on the rear of the power unit with the six bottom-left (PDU-A) or bottom-right (PDU-B) 
screw posts, remove the nuts, washers, frame and logic ground wires. Use a 7/16-inch (11.113-mm) 
socket on the nuts, and needle-nose pliers to remove the star washers.

Note Wiring positions are mirrored for PDU-A and PDU-B with the exception of the green frame 
ground wire to the rear of the bay.

i. Working on the rear of the bay with the top 12 screw posts, use a 7/16-inch (11.113-mm) socket and 
socket driver to remove the last four nuts holding PDU-B to the top-bay busbar. Use needle-nose 
pliers to remove the star washers.

j. Remove the 1/4-inch (6.35-mm) nut and washer from the frame ground lug.

Step 3 Working on the front of the bay, remove the faulty PDU:

a. Use a slot screwdriver to unscrew the two PDU slot screws until they click.

b. Pull the PDU straight out and place the PDU in the ESD-safe area.

Step 4 Continue with the “NTP-F243 Replace the Power Distribution Unit” procedure on page 14-33.
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Stop. You have completed this procedure. 

NTP-F243 Replace the Power Distribution Unit

Note The PDU can be ordered in entirety (including PDU-A, PDU-B, and alarm panel) or by part.

Step 1 Working on the front of the bay:

a. Push the new PDU straight into the cabinet in the shelf.

b. Replace 1/4-inch (6.35-mm) nut and washer on rear frame ground lug.

c. Use a slot screwdriver to tighten the two slot screws on the front of the PDU.

Step 2 Working on the front of the bay, reinsert the alarm unit in the middle of the PDU:

a. Push the alarm unit straight into the cabinet in the bay.

b. Use a slot screwdriver to tighten the two slot screws on the front of the alarm unit.

Step 3 Working on the rear of the bay with the six bottom-right (PDU-A) or bottom-left (PDU-B) screw posts, 
replace the wires and the star washers. Use a 7/16-inch (11.113-mm) socket and wrench to replace the 
second and third nuts on the screw posts.

Note Wiring positions are mirrored for PDU-A and PDU-B with the exception of the green frame 
ground wire to the rear of the bay.

Step 4 Working on the rear of the bay with the top 12 screw posts, replace the busbars, the star washers, and the 
nuts holding the busbars to the PDU. 

Step 5 Working on the rear of the bay, replace the PDU receive output cover over the top 12 screw posts.

Step 6 Working on the rear of the bay, replace the two thumbnuts that secure the PDU receive output cover. 

Step 7 Working on the side of the bay, replace the electrical wiring:

a. Place the green jumper cable on the frame ground and logic ground screw posts.

b. Use a 7/16-inch (11.113-mm) socket and wrench or socket driver to replace the green ground wire 
on the rear-most vertical pair of screw posts. Torque all PDU side screw post nuts to 36 in.-lb.

c. Replace the red 48– VDC power return wire on the third pair of screw posts.

d. Replace the black 48– VDC power supply wire on the fourth pair of screw posts.

Step 8 Working on the side of the bay, replace the plastic safety cover over the power leads.

Purpose This procedure replaces the B-side PDU. To replace the PDU A-side, 
use the same procedure but reverse the wiring screw post positions.

Tools/Equipment Replacement PDU

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 Use the 9/64-inch (3.57-mm) Allen wrench to replace the two nuts that secure the plastic safety cover.

Step 10 Restore power to the bay. 

Step 11 Check the voltage at the PDU input, output, and backplane busbar connections with a voltage meter. See 
the “DLP-F169 Verify Office Power” task on page 16-12.

Stop. You have completed this procedure. 

NTP-F244 Edit Network Element Defaults

Note For a list of card and node default settings, refer to the “Network Element Defaults” appendix in the 
Cisco ONS 15600 SDH Reference Manual. To change card settings individually (that is, without 
changing the defaults), see Chapter 10, “Change Card Settings.” To change node settings, see 
Chapter 11, “Change Node Settings.”

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to edit NE 
defaults. 

Step 2 Click the Provisioning > Defaults tabs. 

Step 3 Under Defaults Selector, choose a card type (if editing card-level defaults), CTC (if editing CTC 
defaults), or NODE (if editing node-level defaults). Clicking on the node name (at the top of the Defaults 
Selector column) lists all available NE defaults in the Default Name column. To selectively display just 
the defaults for a given card type, for node-level, or for CTC-level, you can drill down the Defaults 
Selector menu structure.

Step 4 Locate a default you want to change under Default Name. 

Step 5 Click in the Default Value column for the default property you are changing and either choose a value 
from the drop-down menu (when available), or type in the desired new value.

Note If you click Reset before you click Apply, all values will return to their original settings. 

Step 6 Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You 
can modify multiple default values before applying the changes. 

A pencil icon will appear next to any default value that will be changed as a result of editing the defaults 
file. 

Purpose This procedure edits the factory-configured network element (NE) defaults 
using the NE Defaults editor. The new defaults can either be applied only 
to the node on which they are edited or exported to a file and imported for 
use on other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Step 7 If you are modifying node-level defaults, a dialog box appears telling you that applying defaults for node 
level attributes overrides current provisioning and asks if you want to continue. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or pre-provisioned slots, see 
Chapter 10, “Change Card Settings.”

Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-F245 Import Network Element Defaults

Note For a list of card and node default settings, refer to the “Network Element Defaults” appendix in the 
Cisco ONS 15600 SDH Reference Manual. 

Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to import NE 
defaults.

Step 2 Click the Provisioning > Defaults tabs. 

Step 3 Click Import.

Step 4 Click Browse and browse to the file you are importing if the correct file name and location of the desired 
file do not appear in the Import Defaults from File dialog box.

Step 5 When the correct file name and location appear in the dialog box, click OK. (The correct file name is 
15600SDH-defaults.txt if you are importing the factory defaults.)

Purpose This procedure imports the NE defaults using the NE Defaults editor. The 
defaults can either be imported from the CTC software CD (factory 
defaults) or from a customized file exported and saved from a node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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A pencil icon will appear next to any default value that will be changed as a result of importing the new 
defaults file. 

Step 6 Click Apply. 

Step 7 If the imported file fails to pass all edits, the problem field shows the first encountered problem default 
value that must be fixed. Change the problem default value and click Apply. Repeat until the imported 
file passes all edits successfully.

Step 8 If you are modifying node-level defaults, a dialog box appears telling you that applying defaults for node 
level attributes overrides current provisioning and asks if you want to continue. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or pre-provisioned slots, see 
Chapter 10, “Change Card Settings.”

Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-F246 Export Network Element Defaults

Note The defaults currently displayed are exported whether or not they have been applied to the current node.

Note The NE defaults can also be exported from the File > Export menu. These exported defaults are for 
reference only and cannot be imported.

Purpose This procedure exports the NE defaults using the NE Defaults editor. The 
exported defaults can be imported to other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Step 1 Complete the “DLP-F181 Log into CTC” task on page 16-32 at the node where you want to export NE 
defaults. 

Step 2 Click the Provisioning > Defaults tabs. 

Step 3 Click Export.

Step 4 If the desired file to export to does not appear in the Export Defaults to File dialog box (or does not yet 
exist) click Browse and browse to the directory where you want to export the data; then either choose or 
type in (to create) the file to export to [the defaults will be exported as a text file delimited by equals (=) 
signs].

Step 5 Click OK.

Stop. You have completed this procedure.
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